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STEP 1: Draft your concept

I've decided on the information | wish to present. How to | present it?

Cool Infographics®

O2 E Charts and graphs can communicate data; infographics turn data into information
*
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*
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Pinterest wiiDailyInfographic IIEA
Information is Beautiful

ideas, issues, knowledge, data — visualized|
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Take a look at existing
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infographics for ideas

Online images / blogs / books
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Define the story and

Ceneeia?

sketch it....

=1 Be flexible

There is more than one
way to visualise the same
data so use trial and error
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Search for simple icons

Free Icon and Symbols

Many different sites...but...

For uniformity, the Team
recommends the
thenounproject.com

The Noun Project

H Lk

Over 150,000 icons designed by creators from around the world

Icons for Everything



thenounproject.com
nounproject.com

STEP 2: Find a template

Start as you mean to

goon....

The

S:103-10 RESEARCH & INFORMATION
_ SERVICES\Infographics « Master

Folder

A. Either start with a blank canvass...

S:103-10 RESEARCH & INFORMATION SEVICES\Infographics\

Resources\Templates

TITLE 1 TITLE 1 TITLE1
TITLE1 TITLE 1 TITLE 1

Colour palette  suows:

= TITLE1 TITLE1 TITLE1
Bl TITLE 1 TITLE 1 TITLE 1

nmone mogragmes sna

Colour palette ===

= ees o

mmmmmm

Bills Digest (+ Colour Palette) Standalones / L&RS Notes (+ Colour Palette)

B. Use a previous graphic as a model...

S:103-10 RESEARCH & INFORMATION SERVICES\Infographics

. Resources Check out examples from

. 2014
@) 2015
@ 2016

previous years and use as a

' template

**NB: Do NOT save over these graphics -
open the file and save immediately
into a new folder**


file:///S:/00-13 PROJECT MANAGEMENT/2015 Projects/20150427_Infographic_feasibility/Templates
file:///S:/00-13 PROJECT MANAGEMENT/2015 Projects/20150427_Infographic_feasibility/Templates

STEP 2: Find a template com.

Start as you mean to go on....

B. Use a previous graphic as a template (cont.)

Are you illustrating data? Are you telling a story?

ECONOMIC INDICATORS April 2016
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Source: Economic Indicators (April 2016)

Are you illustrating
a process /
procedure?
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Source: Register of Members Interests (March 2016)
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© Houses of e Otreachtas 2015
Designed by: ireachtas Library & Reszarch Service

Source: Seanad Eireann Electoral Process (April 2015)



file:///S:/03-10 RESEARCH & INFORMATION SERVICES/Proactive Research/2016/Infographics/Register of Members Interests
file:///S:/03-10 RESEARCH & INFORMATION SERVICES/Proactive Research/2015/Economic Indicators 2015/No. 2 May 2016
file:///S:/03-10 RESEARCH & INFORMATION SERVICES/Proactive Research/2015/Infographics/Seanad Electoral Process

STEP 2: Find a template co)

Start as you mean to go on....

C. The template (explained)

TITLE1 TITLE1 TITLE 1
TITLE 1 TITLE 1 TITLE 1 4_0
L&RS logo Arial font,

Capitalised
(Size depends
on title length)

Font colour
R 160
G 154
B 140

Grey (or white) background
(not essential)

R 229
G 228
B 223

@ Hosss of e crsscnss vy | Attribution
* Month Y¥YY Deamlgnead by: Oiraachias Liorary & Rsssanch Sanics

“©O
Date




STEP 3: Design

Publisher has a few handy function tools...

A quick overview...

Draw Text Box
Insert a text box into
the document, or
add text to the
selected shape.

Format Painter
Use the Format
Painter button to
match styles

Home Inse

3 & cut
—— B3 copy
Paste
- jFormat Painter
Clipboard P

Shapes

Part V Planning Process_v3 - Microsoft Publisher

=

icture  Tabl
Text Box <

Paragraph Styles Objects

Arran ge

|4 |1 |-:J |2 |4 |6 |s |1.2 |14 |1.6 |1.s |zo |21 |14
v oo e v e e v o g Lo e b i oo v

Part V Planning Process

Example

P i
emommn

Insert ready-made
shapes, such as
rectangles and
circles, arrows,
lines, flowchart
symbols, and
callouts

Guides

Insert a set of layout
guides that create a
grid pattern.

Layout guides help
you align objects in
your publication.

B

g L Ve

T Cevecger Faming Gan

e ———
pmE

Tt Loc Attty Paning San

e Insert

E HE P =

Table | Piffure Clip Shapes
- Art

Page Design Mailings

Insert Table
Copy and ‘paste
special’ from

Arrows
Insert block or line

Picture
Placeholder

Tables Illustrations MS EXCel / al'rOWS tO ald the
Word or use flow of your story.
Table Tool

Send Backward
Send the selected
object backward so
that it is hidden by
the objects that are
in front of it.

Bring Forward
Bring the selected
object forward one
level or to the front
of all objects.

Group

Join two or more
selected objects
together so they will
be treated as one
object.

Align

Align the edges of
multiple selected
objects (select using
shift key). You can
also centre them or
distribute them
evenly across the

page.

Shape Fill

Fill the selected
shape with a solid
colour, gradient,
picture, or texture.
Iﬁm

Format

| Text Box Tools .

Format

& shape Fill =
I - L shape Outline =
= {?Change Shape

Icons

Add icons (as
JPEGs, PNG or
SVG files) and
position / scale
them.



STEP 3: Design (cont.)

Telling a story...

Add as much
detail as you wish.
See what works /
what doesn’t work
and ask someone
else to check that
the flow of
information makes
sense

Sernro \nroGreeic |

7

Skeleton structure
Add some detail

Oireachtas Library

esearch Service e

TITLE1 TITLE1 TITLE1
TITLE1 TITLE1 TITLE1

) e

© Houss ofthe Omschss YYYY
Designedby: Oeschss Lixay & Resesrch Sanica

: Date and Copyright

1 Mark the date at the bottom of

1 the page along with Oireachtas
signature.

1
1
R

. :read.

Select a standard

template

In this example, we
used the
Standalone, L&RS
Notes and Briefing
Papers Template

i Flow

1 Organise the infor- !
1 mation from left to :
1 right, top to bottom.
' This is how the |
rinfographic will be |
1
1
]

Add some sections
B (based on your sketch) that

(following the sketch) to
frame your graphic

THE SEANAD EIREANN
ELECTORAL PROCESS

THE SEANAD EIREANN
ELECTORAL PROCESS

mo

Apr 2015 © Houses ot Ovsris 2015

Get building

Add more detail (keeping
the same style throughout)

E Spacing i
1 Use light or grey shading :
| to balance the !

; composition of the graphic
; and aid accessibility.

Add shapes:

Using the ‘Shapes’
tool e.g. one circle +
one round rectangle
= a ‘person shape’
or one circle, white
outline, with blue fill
colour and Arial
Black Number...

Add images: Using the
www.nounproject.com

1 1
! Boxes :
! Use ‘stand-out’ boxes to |
! give context and identify |
i key information. 1

xQ

To move / copy shapes:
To move multiple shapes,
textboxes and images,
select one, click and hold
TAB and select more—you
can now move / copy them
together all together

Match colours: Use
shades of the same colour
to tell your story in each
section

THE SEANAD EIREANN
ELECTORAL PROCESS

Aprl 2015

Oireachtas Library

ysiignd oy Apeey
jonpouid paysiui4

will break the information
down

Adjust the bright-
ness/darkness of
the template colours
as need be.

Add headings to
each of the
sections

| Sequencing

1 .

1 Use sequential

| letters and numbers
1 so the story is easy
1 to follow.

THE SEANAD EIREANN
ELECTORAL PROCESS

Vocational Panels. o

RESENTATION



STEP 4: Add text / shapes

So, how do you add text and shapes?

Go to the Home Tab — Draw Text Box or Shapes

styles

= @ Cha, Shape ~
F]

{ Home Insert Page Design Mailings Review View
b cut S AN ® == | EE(E T &v
& Copy
_ R B 7 U x, X Aa~ | 8- [ A == == | = Styles || Duaw
F Format Painter = — ¥ = - Text Box
oboard Fl Font Paragraph Styles
=T 1. . [ I~ 1 1 1= I~ 1 (- 1 f
A
Textboxes Main toolbar ={ Home | OF & Insert | |y
Drraw
Text Box
abcdefghijkim- abcdefghijkim- abcdefghijkim- abcdefghijkim-
nopgrstuvwxyz nopqrstuvwxyz nopgrstuvwxyz nopqrstuvwxyz
Insert Text Add a border Add a colour Change the shape
e Select textbox e Select textbox e Select textbox
* Select e Select e Select e Select
textbox on the main on the main ;
on the main
* Type toolbar toolbar toolbar
e Click SHAPE OUT- e Click SHAPE FILL e Click CHANGE
LINE e Choose a COLOUR SHAPE
e Choose a COLOUR/ and choose darkness/
Adjust thickness brightness
(weight) etc.
I Drawing TertBolels ! I Drawing Tel‘tlknTnnls l .Flm ing qu Text Box Tools l
- Format | Format - Format - Format - Format - Format
£ shape Fill - £ shape Fill =
:] - ] LZ shflk Outline j ~| [ shape Outline ~
styles Fl

or

Home |

Insert

Shapes

Recently Used Shapes

o E@E AT ],
CRTAN

Lines

L S AN

Basic Shapes
EOOTC0® AM
OO0 0o@~™

oo )45

Block Arrows

DA TSP LPR IS

Lots to choose from...

§E dUwnRDDD D
Lo a
Flowchart
OO0< /OO0
o@D X §

Callouts

[1 0060 €3 0.0 A0 0 15 A% A i
A AT 0 AD AD O

Stars and Banners

Fox S v (o 48 g 63 TR AR () I

QBOo

[T RIRY




STEP 5: Manipulate shapes

How do you change shapes and change positioning?

Go to the Home Tab — Draw Shapes '

{ Cut . - A AT | E =iz | EEEE | =S q & bl E_] ’-T_}’J

{ Home Insert Page Design Mailings Review View
K

14
n
W

& Copy

. AV A = = = = || 1= Styles Draw  Picture Table | Shapes
# Format Painter £ U X X Aa *_' == = === - Text Box ~ ~
oboard P Font Paragraph Styles Objects
=Tl [ lan In I- 1. I~ In I~ [ I- [ lan [

Making shapes

SJORORGIC

Insert shape Enlarge shape Colour a shape Adding letters/ To centre text
e Select shape  (Keeping proportions) o Select shape, go to numbers e Highlight text, CLICK
from menu e Select shape, hold main toolbar, click e Select shape, RIGHT TEXT BOX TOOLS
the SHIFT key and DRAWING TOOLS, CLICK, ADD TEXT. then alignment.

e Draw shape

drag shape Click SHAPE OUT- ——
LINE / SHAPE FILL e

=l View
Shift as required_ Ba  Save as Building Block...
£ | T R | =111 —"——
Save as Picture..,

Add Text [olumns Margins | Create
==l - Link

Drawing Tools || Text Box Tnols_

=nment

Sending to front / back @
_ =
r Bring Send
Forward =§ Backward
This is a textbox | creat- This is a textbox | creat-

ed in MS Publisher. This
ia a textbox | created in
MS Publisher. This is a
textbox | created in MS
Publisher.

This is a textbox |
created in MS

You have a shape, with

some text added in. Publisher. This is a
| :
Add a second shape. The first shape tﬁg?fb"g,i?_ted n
Now you want to add a and its text are now hidden.
second shape behind
the first... Click on the second shape, go to

on the main bar. You can also click on the
other shape and ‘Bring
Forward’, etc.

Drawing Tools

Format

10



STEP 6: Import from excel

You’'ve made a chart in Excel. How do | add this to my graphic?

icles Licensed for the First Time (Number) by Taxation Class an d

Apr-06 Apr-07 Apr-08 Apr-03 Apr-10 Apr-11 Apr-12 Apr-13 Apr-14 Apr-13 Apr-16
26,657 28,086 2372 7.555 11.556 13.248 1.263 10,057 14178 16455 19,144
7068 7826 8,253 5,936 5,350 5.075 4,154 5.510 6415 5,361 T.261

\ /\/ = New Vehicles
===5econdhand Vehicles
Open Excel o o
pen Exce /\a&
< 000 /\/

AN S e R
T N Y T S R e
W @ @ R W

Once you make your chart...copy (right click, copy) in Excel + paste
into Publisher as a PNG file

STEP 7: Transparency

How do | match backgrounds?

Your chart But your Publisher page Make the graphic transparent (to
background is background is green.. match the background colour)
white...

- VEHICLES LICENCED aprii 2010 Select the chart...

0w April 2006 - April 2016 (10 years)

o 100,638 i i e
Nawver:\clestdm—Apr. CIICk Plcture TOO'S Sl o0

150 e 2016) —_—

wn *it on the toolbar Formst
a.w‘““vﬁﬂvf,«“““vw““vs‘*.q«“@‘ﬂ«f‘“@““x”“ 25,095 -% ) .
Lol (et | Click Recolour then -

2016)
. I3 ‘Set Transparent ‘ ""\ v d
| Colour’ (to get your :

‘Source: CSO - vehicles licenced for the first time (May 2018) ‘COIour pICker tOOI,) RE cnlﬂr

Then click the background of the
chart...

11



STEP 8: Add icons

Adding icons to your graphic? Use the www.thenounproject.com

To access Icons for Everything
Over 150,000 icons designed by creators from around the world

Visit thenounproject.com

The Noun Project

Free Icon and Symbols

H Lk

All images come in PNG (Portable Network Graphics) and SVG (Scalable
Vector Graphics) format. What's the difference? For our purposes, not

much.
PNGs SVGs
o Are less customizable; e Are more customizable;
e Can lose resolution when you e Can be resized and recoloured;
change the size of them; o Are better quality (rendering)
e Can look lower quality on older and more suited to newer
browsers. browsers.

Search and copy Book
By Dalpat Prajapati, IN
* Search for anything I |

6 B & 3 LEE AN '
B mg - “ e 8 = 1 A

(-3

il
L

Open the file (it will Open Save F Cancel | x

Search (e.g. ‘book’) Select an icon, click
‘Download’ and PNG

open in Windows Photo
viewer. Then Copy and Click ‘Save As’ at bottom of page
Paste into your

Publisher Doc and save to desktop, etc.

12


thenounproject.com
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STEP 8: Add icons (cont.)

You've added your icons. How do you recolour them?

To recolour icons

Compress Pictures

% Change Picture -

] Ficture Tools I Erightness ContrastfRecolor
- - - 7 Reset Picture
Format
Select your icon Click Picture Tools Click RECOLOR
then FORMAT on then
the top bar MORE VARIATIONS on the
ribbon

| Colors @
Recolor Picture @ Stendard | Custom | | PANTONE® | [ ]

Preview Recolor whole picture B -

Leave black parts black
[ OK ] [ Cancel ] ’ Apply ] NEEW
Use the Color drop down

menu indicated above Choose a scheme colour

OR

Click MORE COLORS
(enter your desired RGB code
/ see Appendix 1)

Colour changed



STEP 9: Speed up Publisher

Is Publisher chugging along? Heres a tip to speed it up.

Go to the View Tab — Check Graphics Manager Box

D= A

)| @

Normal| Master

v]=

Page
Views

_Page

Insert

Single |Two-Page

Spread
Layout

Mailings

[ Boundaries Rulers

Review

View

[] Graphics Manager

Page Navigation []| Baselines

Scratch Area
Show

Click here

In the right hand
column...

Graphics Manager
Display options
Show: | All pictures

Sortby: | File name
[ show thumbnail

Select a picture

[l ]

[Untitled].jpg (Page 3)
Embedded (544 KB)

[Untitled] .jpg (Page 13)
Embedded (544 KB)
Embedded (489 KB)

22092015 v1.jpg (Page 13)
Embedded (83 KB)

22092015 v2.jpg (Page 13)
Embedded (113 KE)

Embedded (75 KB)

Embedded (25 KB)

dip_imaged01.jpg (Page 1)
Embedded (293 KB)

dip_image001.jpg (Page 14)
Embedded (293 KE)
Embedded (25 KB)

Excel.gif (Page 12)
Embedded (22 KB)

Excel.gif (Page 12)
Embedded (22 KB)

20072015_Draft_infographic. jpr

26082015 Draft Template (Stan

Ched:_mark_23x20_02_svg.pn

eprs_logo_for_blog.png (Page :

»

m

*I Change picture display...

a Help with Graphics Manager

And click here...

-
Picture Display

A=)

(") Detailed display
Select this option if you want Publisher to show pictures using

maximum detail. Large pictures or photographic images might
take a long time to draw on your screen.

Select this option if you want to zoom or resize photos,
scanned images, or bitmaps quickly. Images on your screen
might have low detail, but will print with full accuracy.

() Hide pictures
Select this option if you don't want Publisher to draw pictures
at all. The images will print with full accuracy.

[ QK ] [ Cancel

Now all images will appear as this.
You can preview an image by
clicking and dragging it...

14



Appendix 1: Colour palette

L&RS Notes, Standalone In-
fographics and other Papers

Oireachtas Library
& Research Service

his Leabharlainne & Taighde an Oireachtais

Houses of the Oireachtas
ithe an Oireachtais

R222
G119
B76

Lettering / Numbering
R255 G255 B185

R79
G129
B189

| B|IIs ‘Dlges‘f

R178
G111
BO

Base Colour

R178 R255
G143 G130 G111 G159
B255 B255 BO BO

R86 R9 R43 R7
G172 G135 G86 G108
B255 B255 B127 B204

R25 RO

Base Colour

R150 R165 R55 R73
G186 G255 G88 G117
B88 B9 B95 B134

R234 R206 R117 R165
G255 G255 G127 G204
B197 B121 B99 B97

Base Colour

R255 R255 RO R9
G122 G106 G170 G244
B35 B9 B178 B255

R255 R255 R127 R204
G212 G166 G106 G133
B184 B107 B92 B86

R5 G73 B138

Complementary
Colours

Analogous (Dominant/
Secondary)
Colours

R150 G186 B88

Complementary
Colours

Analogous (Dominant/
Secondary)
Colours

R214 G139 B9O

Complementary
Colours

Analogous (Dominant/
Secondary)
Colours

Colour schemes chosen via Adobe Kuler at color.adobe.com. User can also select different colour rules includ-
ing analogous (dominant/secondary colours), monochromatic (single / same hue), triad (three colours evenly
spaced on the colour wheel), complementary, compound (earth colours, opposite ends to colour spectrum),

shades (various lightened and darkened versions of the chosen colour) and custom.



https://color.adobe.com

